Sociology 202 – Fall 2005

Lab 2: Using charts in Excel.

OBJECTIVE:

In this lab exercise, you will practice using Excel charts to display data.  You will use the polviews and absingle variables from the GSS that we studied last week.

SCENARIO:

In the last lab, you imagined yourself to be an investigative reporter writing about whether social attitudes on important political topics have become more polarized over time.  The evidence you found supported that hypothesis.  This week, you are going to create some charts displaying those findings.

WHAT TO TURN IN:

In a separate document, you will answer each numbered question in one or more full sentences.  You will also turn in the charts you create and the Excel spreadsheet the charts are drawn from.

SECTION 1: Displaying Political Views with a Pie Chart

A. Go to the website for the SDA Archive at http://sda.berkeley.edu:7502/ (or google SDA Archive).

· Click on “GSS Cumulative Datafile 1972-2002 – Full Analysis.”

· Select “Frequencies or Crosstabulation (with charts)” and click “Start.”

· Identify the variable for our univariate analysis.  Type the following in the window for ROW:


polviews

· Set the selection filters.  Type the following in the window for SELECTION FILTERS:


year(1998-2002)

· Click “Run the Table.”

B.
Open Microsoft Excel.  Create a spreadsheet with the frequencies for each category, with the categories and frequencies in columns.  It should look something like this (fill in the remaining blanks with data from the GSS):

	polviews 1998-2002
	

	
	frequency

	Extremely Liberal
	218

	Liberal
	808

	Slightly Liberal
	

	Moderate
	

	Slightly Conservative
	

	Conservative
	

	Extremely Conservative
	


C.
Create a chart.  
· Step 1 – Highlight the category names and frequencies by clicking and dragging the region from the cell titled “Extremely liberal” over and down to the cell containing the frequency count for “Extremely conservative.

· Step 2 – Click the “chart wizard” icon (the one with the blue, yellow, and red bars).

· Step 3 – Select the Pie Chart, click next.

· Step 4 – Double-check that series is in columns, click next.

· Step 5 – Titles: write a clear title for the chart; Data Labels: select show percent; click next.

· Step 6 – Select “as new sheet” and name the new sheet “pie chart;” click finish.  You should now have a multi-colored pie chart in its own worksheet.

D.  Format the chart.

· Change the font size of the chart’s title.  Right click on the title and click on “Format Chart Title.”  Click the Font tab.  Clear the check mark in Auto Scale and change the font size to 16 point.  Click OK.

· Change the font size of the Data Labels and Legend to 12 point font, using a similar process as above.

· Add a decimal place to the data labels.  Right click on a data label and select Format Data Labels.  Click on the Number tab.  Change Decimal Places to 1.  Click OK.

· Create a footer with your name and the date.  In the View menu, select Header and Footer.  Click Custom Footer and put your name and the date in the Right Section.  Click OK, and click OK again.

· A chart with this many colors will not come out well on a black and white printer.  In the File menu, select Page Set Up.  Click the Chart tab and select Print in Black and White.  Click OK.  Click on the Print Preview icon to see what the chart will look like when it prints.




Note:  Alternately, you can select the shades of gray and patterns yourself.  


To do so, click on one wedge of the pie, then click Format Data Series, 




then choose your own shade of gray or texture for that wedge.  Repeat the




procedure for each wedge in turn.  
1.)
Print the chart.

2)  What percentage of Americans consider themselves extremely liberal?  Does this match the column percent from the SDA Archive Table?

3)  What percentage of the population is moderate, slightly conservative, or slightly liberal?  
4)  Write a paragraph to guide the reader through at least one important conclusion that might be drawn from this chart.  For example, how do you think these results might affect the way politicians campaign?

5.)  Write a few sentences to describe how well you think this pie chart gets the point across.  Identify at least one strong point and one weak point of this particular chart.
SECTION 2: Displaying changes in support for abortion rights over time with a line chart.

A.
Go back to the SDA Archive and run a cross-tabulation for polviews and absingle for 1978-1982 and 1998-2002.

· Type the following in the window for ROW:


absingle

· Type the following in the window for COLUMN:


polviews

· Type the following in the window for SELECTION FILTERS:


year(1978-1982)

· Click Run the Table.

B.
Create an Excel spreadsheet with the polviews categories in the first column and the percentage of each category SUPPORTING abortion rights for single women in the second column.  It should look like this (fill in the remaining blanks with data from the GSS):

	Response to Variable absingle = Yes
	

	
	1978-1982

	Extremely Liberal
	57.8

	Liberal
	54.2

	Slightly Liberal
	

	Moderate
	

	Slightly Conservative
	

	Conservative
	

	Extremely Conservative
	


C.
Repeat Step A of this section, but use year(1998-2002) in the Selection Filter.  Add a column for 1998 – 2002 to your spreadsheet.  It should now look like this (fill in the blanks with data from the GSS):

	Response to Variable absingle = Yes
	
	

	
	1978-1982
	1998-2002

	Extremely Liberal
	57.8
	66.9

	Liberal
	54.2
	57.9

	Slightly Liberal
	
	

	Moderate
	
	

	Slightly Conservative
	
	

	Conservative
	
	

	Extremely Conservative
	
	


D.
Create a chart.  Highlight the category names and frequencies and click the “chart wizard” icon.

· Step 1 – Select the Line Chart, click next.

· Step 2 – Double-check that series is in columns, click next.

· Step 3 – Titles: write a clear title for the chart and label the Y axis; Data Labels: select Show Value; click next.

· Step 4 – Select “as new sheet” and name the new sheet “line chart;” click finish.  You should now have a line chart in its own worksheet.

E.
Format the chart.

· Remove some excess ink from the chart by reformatting the plot area.  Click on the area, then click Format Plot area, then set Border to None and Area to None.

· Remove some more excess ink from the chart by reformatting the y-axis.  Click on the y-axis line, then click Format Axis, then Scale.  Set Minimum to 0, Maximum to 100, and Major Unit to 20.

· Change the font size of the title, data labels, legend, and Y axis (see section 1 for details).

· Make sure the data labels all have the same number of decimal places.  Right click on a data label, select Format Data Labels, and click on Number.  In Category, select number, and set Decimal Places to 1.  Click OK.

· Make sure the lines will be distinguishable in a black and white print out.  Click on one of the little squares or diamonds and select Format Data Series.  Click on the Patterns tab.  Set marker size to 8 points.  Click OK and repeat for the other data series.

· Add a footer with your name and the date (see section 1 for instructions).

6).
Print the chart.

7)
Write a few sentences describing the data in this chart and explaining their interpretation to the reader. 
8)
Between which two categories do the lines cross?  Does this make sense to you?

9)
If you could somehow “straighten out” these two lines, which time period would have a steeper slope?  

SECTION 3:  Use a column chart to display data on increased polarization a different way.

A.
Add a fourth column to the last spreadsheet we used.  This column will display the difference between the two time periods.

· In the cell just to the right of the percent for Extremely Liberal, 1978-1982, enter a formula that will subtract the 1978-1982 percent from the 1998-2002 percent.  It will look something like this:


=B14-C14

Formulas always begin with an equals sign.  “B14” is a cell name: B is the column and 14 is the row.  Use the cell names appropriate to your spreadsheet.

· Repeat the formula for the rest of the polviews categories.  You can type it in each one, changing cell names as you go.  Or, you can copy and paste, and Excel will change the cell names for you.  Your spreadsheet will now look something like this (fill in the blanks with data from the GSS):

	Response to Variable absingle = Yes
	
	
	

	
	1978-1982
	1998-2002
	Difference

	Extremely Liberal
	57.8
	66.9
	-9.1

	Liberal
	54.2
	57.9
	-3.7

	Slightly Liberal
	
	
	

	Moderate
	
	
	

	Slightly Conservative
	
	
	

	Conservative
	
	
	

	Extremely Conservative
	
	
	


B.
Create a chart.  Highlight just the polviews category names and the Difference column.  (You can do this be clicking and dragging over the first column, then ctrl-click and dragging over the Difference column.)  Then click the chart wizard icon.

· Step 1 – Select the Column Chart, click next.

· Step 2 – Double-check that series is in columns, click next.

· Step 3 – Titles: write a clear title for the chart and label the Y axis; Legend: clear check mark in Show Legend; Data Labels: select Show Value; click next.

· Step 4 – Select “as new sheet” and name the new sheet “column chart;” click finish.  You should now have a column chart in its own worksheet.

C.
Format the chart.

· Change the background fields and axis scales to make a clean graph (see section 2 for ideas on how to do this).

· Change the font size of the title, data labels, and Y axis (see section 1 for details).

· Right click on of the columns and select Format Data Series.  Make the bars a different color, but be sure it is one that will show up well in a black and white print out, but is not so dark that the category labels will be hard to read.

· Add a footer with your name and the date (see section 1 for instructions).

10)
Print the chart.

11)
Write a few sentences describing this chart.

12)
Which group changed the most from around 1980 to around 2000?  Which group changed the least? 

13)  Which group increased support the most?  Which group decreased support the most?

SECTION 4:  Use a different column chart to display data on increased polarization in one more way.

A.
Create a chart.  Highlight the same category names and frequencies you highlighted in section 2 for the line graph, and click the “chart wizard” icon.

· Step 1 – Select the Column Chart, click next.

· Step 2 – Select that series be presented in rows, click next.

· Step 3 – Titles: write a clear title for the chart and label the Y axis; Data Labels: select Show Value; click next.

· Step 4 – Select “as new sheet” and name the new sheet “column chart 2;” click finish.  You should now have a new column chart in its own worksheet.

B. Format the chart.  From previous charts, you should have ideas about how to make a thorough but clean presentation.  Use your skills to select the best shades for the bars and background field, rescale the axes as necessary, and add or modify data labels and fonts.  Make it look good.

14)  Print the chart

15)
Write a few sentences describing this chart.  Your description should be similar but not identical to the description for section 3, because you are presenting the same data with different emphasis.

16)
 Of the charts in Sections 1, 2, 3, and 4, list at least one advantages and disadvantage    of each chart.

17)  Decide which chart or charts you would choose to include with your article, and explain your choice. 

18) Print your spreadsheet work.

To do this, make sure you are in the sheet with the numbers (not the charts).  In the File menu, select Page Setup.  Click on the Header/Footer tab and put your name and the date in a custom footer, as with the charts.  Click on the Sheet tab and select Gridlines.  Click on the Page tab and decide which Orientation you prefer.  Click Print Preview, and make sure everything looks OK.  If so, print your spreadsheet.  This will document your work
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